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1 « Unpacking the ICS-90 System

This manual provides instructions for the initial installation of the ICS-90 lon
Chromatography System (ICS-90). Follow these installation instructions step-by-
step, in the order specified.

A newer version of the ICS-90, called the ICS-90A, has a feature that allows the
approximate flow rate to be displayed in Chromeleon® Chromatography
Management System or Chromeleon Xpress. Unless otherwise specified, all of the
information in this manual applies to both the ICS-90 and the ICS-90A. If you are
unsure which system you have, check the model data label on the rear panel.

IMPORTANT It is especially important to install Chromeleon or Chromeleon Xpress

before connecting the USB cable from the computer to the ICS-90 and
before turning on the ICS-90 power.

1.1 Facility Requirements

Make sure the 1CS-90 installation site meets the following environmental
specifications:

Operating Temperature: 10 to 35 °C (50 to 95 °F)
Humidity: 5% to 95% relative humidity, noncondensing

The 1CS-90 requires a sturdy workbench of a height that ensures convenient
access to the interior.

Allow at least 15 cm (6 in) behind the ICS-90 for power connections and
ventilation. For optimal performance, install the ICS-90 in a draft-free
location, out of the path of air conditioning and heating vents.

A clean gas source regulated to between 0.55 and 0.83 MPa (80 and 120 psi)
is required for pressurization of the eluent reservoir.

Use ASTM filtered, Type | (18-megohm) deionized water when preparing
eluent and regenerant.
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ICS-90 Installation Instructions

1.2 Unpacking the ICS-90 System

1.2.1

CAUTION

MISE EN GARDE

VORSICHT

Unpacking the ICS-90

1.
2.

Open the shipping box.

Remove the eluent reservoir assembly and the 1CS-90 Ship Kit
(P/N 059947).

Remove the foam cover.

Using the cardboard side handles, carefully remove the ICS-90 from
the box. You may need to remove the foam at the sides of the ICS-90
before you can lift the instrument from the box.

Lift the ICS-90 only from each side of the cabinet bottom. Lifting from
the front door will damage the door hinges. Use caution when lifting
the module: it weighs 19 kg (42 Ib).

Ne soulevez le ICS-90 que par le fond ou les c6tés. Son soulévement
par la porte du panneau avant endommagera les charniéres de la
porte. Soyez prudent lorsque vous soulevez le ICS-90: il pése 19 kg
(42 1b).

Heben Sie das ICS-90 nur an, indem Sie von beiden Seiten unter den
Boden greifen. Wenn Sie das Gerat an der Vordertir anheben,
beschédigen Sie die Turangeln. Vorsicht beim Heben des Moduls: Es
wiegt 19 kg.

5.

6.

Set the 1CS-90 on a workbench and cut the tape to remove the plastic
surrounding the instrument.

Inspect the 1CS-90 for any shipping damage.
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1 « Unpacking the ICS-90 System

1.2.2 Removing the Pump Shipping Screw
1. Carefully lay the ICS-90 on its back or side.

2. Locate the middle screw on the bottom of the ICS-90 (see
Figure 1-1). This screw secures the pump in place during shipment.

3. Use a Phillips screwdriver to remove the shipping screw.

4. A screw holder is located to the right of the screw (see Figure 1-1).
Place the screw in the holder for safekeeping. You will need to
reinstall the screw if the ICS-90 is shipped to another location.

5. Return the ICS-90 to an upright position.

Front
n
1 1\
©
o &= Screw Holder
Shipping Screw

-

T~

Bottom View of 1ICS-90

Rear

Figure 1-1. Pump Shipping Screw Removal

Doc. 031856-03 12/06 3



ICS-90 Installation Instructions

1.2.3

Unpacking the Computer

Outside North America

1.

Remove the computer and all documentation from the computer box
and place them on a workbench.

Chromeleon and Chromeleon Xpress run under the Microsoft®
Windows® XP and Windows® 2000 operating systems. Refer to
http://www.dionex.com to verify that the PC meets current system
specifications.

Follow the instructions in the computer installation guide to hook up
the PC components.

When you finish, go to Section 2.1 to install the chromatography
software.

North America Only

NOTE These instructions assume that Chromeleon or
Chromeleon Xpress and the software license were
installed on the PC before shipment from Dionex.

Remove the computer and all documentation from the computer box
and place them on a workbench.

Follow the instructions in the computer installation guide to hook up
the PC components.

When you finish, go to Section 2.2 to connect the PC to the 1CS-90.
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2 + Installing the ICS-90 System

2.1 Installing the Chromatography Software

2.1.1 Installing the Software

NOTE Dionex strongly recommends installing Chromeleon
or Chromeleon Xpress chromatography software
before connecting the ICS-90 to the computer on
which the software is installed. When the
chromatography software is installed first, USB
driver information is loaded automatically and the
Windows operating system will detect the 1CS-90
when the power is turned on.

The SETUP.EXE file on the Chromeleon CD-ROM installs Chromeleon
or Chromeleon Xpress. After presenting a series of options for your
consideration, the Setup program then copies the software onto the hard
disk.

1.

If this is a local computer, log onto Windows XP or Windows 2000 as
an administrator. If this is a network computer, log on as a user with
local computer administrator privileges.

If necessary, ask the computer systems administrator for temporary
administrator privileges. (Administrator privileges are required to
install Chromeleon or Chromeleon Xpress, but not to operate it.)

Verify that the drive on which you plan to install the Chromeleon or
Chromeleon Xpress application has at least 250 MB of free disk
space. This is the amount of free disk space required for operation.

Chromeleon only: 250 MB may not be enough disk space to store
the large amounts of data that Chromeleon can generate. If necessary,
you can store data at a different location (for example, on a network).
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ICS-90 Installation Instructions

3. Insert the Chromeleon CD-ROM into the PC drive. The Chromeleon
Setup menu should appear.

If the Setup menu does not appear automatically, go to the Autorun
folder on the Chromeleon CD-ROM and double-click autorun.exe.
(The .exe extension is not always visible; it depends on the computer
settings.)

4. Select Launch Chromeleon Setup.

5. Setup now guides you through the installation procedure; follow the
on-screen instructions as they appear.

6. When prompted whether to add the Server Monitor program to the
Startup group, select Yes if the computer will be physically connected
to devices or No if the computer will never be connected to devices.

When Yes is selected, the Server Monitor automatically starts when
the computer is started and the program icon is displayed on the
taskbar.

7. After installing the software, restart the computer.

8. Microsoft Windows should automatically detect the 1CS-90 and
launch the Found New Hardware Wizard. (If this does not happen,
refer to the Troubleshooting Tip below.) Complete the wizard by
selecting the following options:

a. If asked whether Windows can connect to Windows Update to
search for software, select No, not this time.

b. Accept the default option (Install the software automatically)
and click Next >.

c. When the wizard reports that the software for the module has
been installed, click Finish.

Troubleshooting Tip

If a Microsoft Windows message box asks for the USB configuration file
(cmwdmush.inf), it indicates that you connected the 1CS-90 to the PC and
turned on the 1CS-90 power before installing Chromeleon or Chromeleon
Xpress.

Follow these steps to resolve the problem:

1. Click Cancel in the Windows message box.
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2 « Installing the ICS-90 System

2. Turn off the power to the ICS-90 and unplug the USB cable from the
computer.

3. Install Chromeleon or Chromeleon Xpress.

4. Reconnect the USB cable to the computer and turn on the power to
the 1CS-90. Windows will now automatically recognize the 1CS-90.

2.1.2 Installing the Software License

In order for the Chromeleon or Chromeleon Xpress computer to control
the 1CS-90, a valid software license must be installed. To install the
license, you must first install a dongle on the computer and then enter a
license Key Code in Chromeleon. (A dongle is an adapter that is
connected to the parallel PC interface or USB port. The dongle stores the
serial number of a Chromeleon computer.)

NOTE If the software license is managed via a License
Server, a dongle is not required.

1. Plug the dongle into the appropriate port on the computer (either a
parallel or USB port, depending on the type of dongle). For a parallel
port dongle, be sure to tighten the connector screws.

2. Ifitis not already running, start the Chromeleon Server Monitor
(select Start > Chromeleon > Server Monitor).

The Server Monitor window opens.
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ICS-90 Installation Instructions

= If Chromeleon or Chromeleon Xpress was installed on the
computer before shipping, the Server Monitor status will display
“Chromeleon Server is running idle.” (This is because the license
Key Code was entered before shipping.) If this is the case, click
Close and go Section 2.5.1 to create a timebase.

e |f Chromeleon or Chromeleon Xpress was not pre-installed, the
Server Monitor status displays “Chromeleon Server is running
idle (Evaluation Mode).” (see Figure 2-1). If this is the case, go

on to Step 3.

*¥% C hromeleon - Server Monitor

— Status Close
% | Chromeleon Server is running idle (Evaluation Mode).

:

Help |

i Stap |

|

Qluit konitar

Serial Mao: 648

— Options
[T Start Server at System Start

Figure 2-1. Server Evaluation Mode

3. Open the Chromeleon Server Configuration program (select Start >
Chromeleon > Server Configuration).
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2 « Installing the ICS-90 System

4. Select Edit > Properties to open the Server Configuration properties
dialog box (see Figure 2-2). Click Dongle and then enter the Key
Code provided with the Chromeleon license. Click OK.

Server AMAR Configuration | ]

License |Advanced | Access Controll

Key Code: |F82K2E—DDZ><Z?

— Copy Protection Location
¢ Mone (demo moda)

 Hardprotect (Fis} IDxDSDf 3:

" Dionex AD Converter

 UVD3405/170S Interface [Fin] IDXDS'IB 3:
 Pump Contral Card [Fis] IDXDSDD 3:

 License Servar IAT—DD |

oK I Cancel | Al | Help |

Figure 2-2. Server Configuration Properties

5. Check the Server Monitor status. It should now display “Chromeleon
Server is running idle.” (see Figure 2-3).

*# Chromeleon Server Monitor = B3

— Status

% |Chr0me|eon Senver is running idle.
Help

et I St | . X
1= op Qluit konitar

Close

1d:

Serial Mao: 648

— Options
[T Start Server at System Start

Figure 2-3. Server Running

6. Click Close to close the Server Monitor window.
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ICS-90 Installation Instructions

2.1.3 Starting the Chromeleon Server Monitor

1. If the Chromeleon Server Monitor program did not start
automatically, start it now by double-clicking the Server Monitor icon
on the Windows taskbar.

If the Server Monitor icon is not on the taskbar, click Start on the
taskbar and select All Programs (or Programs, depending on the
operating system) > Chromeleon > Server Monitor.

2. If the server is not already running, start it by clicking Start.

* Chromeleon Server Monitor !E[E

— Statug il

ﬁ |Chromelean Server iz not wnning,
Help
il . .
: il Cluit M onitor

Config...

il

Senal Mo: n.a.

3. Click Close to close the Server Monitor program window.

The Server Monitor icon appears on the taskbar.

NOTE Clicking the Quit Monitor button quits (or
exits) the Server Monitor program, but does not
stop the server. To stop the server, click the Stop
button.
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2 « Installing the ICS-90 System

2.2

Connecting the ICS-90 to the Computer

The ICS-90 rear panel (see Figure 2-4) provides one USB receptacle. Select one
of the following methods for connecting the ICS-90 to the PC on which
Chromeleon or Chromeleon Xpress is installed:

e Connect the ICS-90 directly to a USB port on the PC.

e If there are no unused USB ports on the PC, connect the 1CS-90 to an external
USB hub (P/N 060392) and connect the PC to the hub.

If the dongle provided with Chromeleon or Chromeleon Xpress is for a USB port,
remember to reserve a USB port on either the PC or the hub for the dongle.

IMPORTANT Before connecting the USB cable and turning on the ICS-90 power,

verify that Chromeleon or Chromeleon Xpress is installed on the PC
(see Section 2.1.1).

Liquid Lines \'* 4
/’ e =

UsB

—r$ Receptacle

[@ TTL

s / Connector
Power Switch I"I""""

Main Power
Receptacle

Waste Lines

|

Figure 2-4. 1CS-90 Rear Panel
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ICS-90 Installation Instructions

To connect the ICS-90 directly to the PC:

1. Locate the USB cable (P/N 960777) provided in the ICS-90 Ship Kit
(P/N 059947).

2. Plug the “A” connector of the USB cable into the USB port on the PC
(see Figure 2-5).

3. Plug the “B” connector of the USB cable into the USB receptacle on
the 1CS-90 rear panel (see Figure 2-5).

USB Cable
1CS-90 (P/N 960777)

Plug the USB cable’s “B” PC }

connector into the USB

receptacle on the ICS-90.
Plug the USB cable’s “A”
connector into the USB
port on the PC.

Figure 2-5. Example Connections: One ICS-90 Connected to the Computer

To connect the ICS-90 to an external hub (P/N 060392):

The 1CS-90 Ship Kit (P/N 059947) includes one USB cable
(P/N 960777). You must order another USB cable for this configuration.

The USB standard limits the USB cable length to 5 m (5.5 yds). Each
USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 m (32 yds)
from the PC.

IMPORTANT Carefully secure all USB cables, the external hub, and the hub power
cable so that they cannot be accidentally disconnected.

1. Plug the “A” connector of a USB cable into a port on the external
USB hub (see Figure 2-6).

2. Plug the “B” connector of the cable into the USB receptacle on the
ICS-90 rear panel (see Figure 2-6).
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2 « Installing the ICS-90 System

USB
Device

USB
Device

USB Cables

Plug the USB cable’s “B” connector
into the USB receptacle on the ICS-90.
Plug the USB cable’s “A” connector
into the “A” port on the USB hub.

PC

Plug the USB cable’s “A” connector
into the USB port on the PC.

Plug the USB cable’s “B” connector
into the “B” port on the USB hub.

USB Hub

Figure 2-6. Example Connections: Multiple Modules Connected to an External Hub

3. Plug the “A” connector of a USB cable into a USB port on the
computer (see Figure 2-6).

4. Plug the “B” connector of the cable into a port on the USB hub.

2.3 Connecting the Power Cord

1. Alabel on the ICS-90 rear panel indicates the line frequency (60 Hz or 50 Hz)
and voltage (110 to 120 VAC or 220 to 240 VAC) for which the system is
designed. Make sure the frequency and voltage are appropriate for your
location. If you are unsure, consult an electrician.

2. Connect the power cord (IEC 320 C13) from the main power receptacle on
the rear panel (see Figure 2-4) to a grounded power source.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-90 or connect it to AC power mains
without an earthed ground connection.

WARNING
The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-90 and is easily
accessible.

CAUTION
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ICS-90 Installation Instructions

Operation at AC input levels outside of the specified operating voltage
range may damage the ICS-90.

P>

CAUTION

DANGER D'ELECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne I'utilisez pas et ne

le branchez pas au secteur C.A. sans utiliser de branchement mis a la
MISE EN GARDE terre

>

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez & ce que la prise de base soit
situéelinstallée prés du module et facilement accessible.

>

MISE EN GARDE

STROMSCHLAGGEFAHR—Zur  Vermeidung  von elektrischen
Schlégen ist eine geerdete Steckdose zu verwenden. Das Gerat darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
WARNUNG  Wwerden.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daf? sich die Steckdose nahe am Gerat befindet und
leicht zuganglich ist.

> P

VORSICHT

2.4 Turning on the ICS-90 Power

Before turning on the ICS-90 power, verify that Chromeleon or
m Chromeleon Xpress is installed. If the chromatography software is not
——— installed first, the Windows operating system will be unable to identify
the new USB device.

1. Turn on the computer power. If this is a local computer, log onto Windows XP
or Windows 2000 as an administrator. If this is a network computer, log on
as a user with local computer administrator privileges.

2. Turn on the power to the ICS-90. The operating system automatically detects
the new USB device. A message flashes on the screen to inform you that the
device was detected.
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2 « Installing the ICS-90 System

2.5 Setting Up the Chromatography Software

2.5.1 Creating a Timebase
1. Inthe Server Configuration program, select Edit > Add Timebase.

2. A clock icon appears under the server name with a default name
highlighted. To use the default name, press Enter. To use a different

name, type the name and press Enter. Figure 2-7 shows an example
timebase named 1CS-90.

#% Server Configuration-Chromeleon Server Configuration
File Edit ¥iew Serser Help

B LR 2N EEDF R NV
- AMAR

- Sharable Devices
=-{&y DEMO

: @ Dionex ASKF100 Autosampler
£ Dionex PS80 Purmp
Dionex |LWD3405 FDA

Figure 2-7. Example: Creating a Timebase

3. Select Edit >Add Device. The Add device to timebase dialog box
appears.

+% Add device to timebase x|

Timebase Name:  |C5-0

Marufacturers: Devices:

Dionex =
IC: ICS-3000 Systems

9 4550 Autosampler [USE] :]
D120 IC System
= IC20IC System

IC: Integrated 5

IC: Modules

HPLC: Surnemit Systems

HFLC; Autopurification Systems

HFPLLC: Gynkotek Systems

HPLL: Modules

LC Packings Capillary/Mano LC Modules
Generic

ABI ICS-1500 IC System

Agilent & ICS-2000 IC System

Antec

Berthald = ICS-90IC System —

I

RN

Figure 2-8. Add Device to Timebase Dialog Box
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ICS-90 Installation Instructions

4. Select ICS-90 IC System from the list and click OK. A dialog box

appears.
]
Demo Chromatogram | Pressure | Calibration | Diagnostics |

General I Signals | Options | State Devices | EnorlLevels |

Device Name: |Pump_ECD|

—Mode
€ Live

Module Serial No: |

Use Live mode to control a physical module connected to the server.
Virtual mode can be used to demonstrate the software support for
the module and allows one to create methods and panels without
having a physical module attached to the server.

[ ok | cance | 2oy | Help |

Figure 2-9. 1CS-90 Configuration Properties: Live Mode

5. On the General tab page, Live Mode is selected by default. Select
the 1CS-90 serial number from the drop-down list. If you are
installing more than one ICS-90, you can verify the serial number for
each system by checking the label at the top of the component panel

(see Figure 2-16).
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2 « Installing the ICS-90 System

6.
Dionex ICS-90 IC System x|

Click Options to display the Options tab page.

Demo Chromatogram | Pressure ] Calibration ] Diagnostics I
General | Signals Options I State Devices | EnorLevels |

~ Set Detection Limits

10.

11.

I P P

Select the conductivity range (0 to 500 uS or 0 to 10,000 uS) from the
drop-down list under Set Detection Limits. Selecting the larger
(coarse) range reduces the detector’s resolution by a factor of 20.

NOTE The Set Detection Limits option is not enabled
unless Moduleware version >1.3 is installed in
your 1CS-90.

Click OK to close the properties dialog box.

Save the configuration (select File > Save Installation).

The Server Configuration Check message window appears. You can
ignore the “no inject device installed” warning, if it appears. This
simply means that the timebase does not include an autosampler.
Click Close.

Exit the Server Configuration program.

Doc. 031856-03 12/06
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ICS-90 Installation Instructions

2.5.2 Connecting to the Control Panel

1. Click Start on the Windows taskbar and select All Programs (or
Programs) > Chromeleon > Chromeleon to start the Chromeleon
client.

2. If Chromeleon is installed, select View > Default Panel Tabset or
click on the toolbar to display the panel tabset.

NOTE If Chromeleon Xpress is installed, starting the
client automatically displays the panel tabset.

3. Todisplay the ICS-90 (or ICS-90A) Control panel (see Figure 2-10),
select the 1CS-90 tab on the panel tabset. (The ICS-90A Control
panel includes a Wellness Panel button; otherwise, the panels are

3 Panel Tabsetl _[afx]|
System_1 £ ¢
IC5-50/ Timebase: System 1 Computer name: CMADLERT ISequence Contmll Stalusl
Sampl Audit Trail
Datasource: | | Elapsed Time: \ 4 10:19:51 AM Manually sequired samples will be stored temporarily in N
sequence "SEQ:ACMADLER_localdystem_Timanual’.
| | Run Time; 010:19:51 AM Chromeleon server version 5,80 SP2 Build 2249 (Beta) stated
(erial number 48],
Sample: | | 010:20:19 A User Chiadler from CMADLER1) has connected Sener
| Configuration to this server,
Progran: | ‘ 10:20:38 AN IC5-80 - Chromeleon 1£5-90 Detector Driver, Vewion .30 §P2 ¥
1CS-90 Syst
-Conneet ——————————— # from Pos.
) 500
~ 5 ECO_1
0.017
Conductivity i
! 3004
Total: -0.07 ps
Autozero
Pump——————————— 2004
On Off
i 22
Valv min
1Positi -0.50
L T T T 1
— 0.00 0.50 1.00 1.50 2.00 2.50 1.00 1.50 400
Load | mject |

Figure 2-10. ICS-90 Control Panel on the Panel Tabset
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2 « Installing the ICS-90 System

4. If a“Cannot connect to timebase...” message appears, click OK to
close it.

NOTE If the timebase was named “ICS-90” when it
was created, the Control panel opens and
connects automatically to the 1CS-90 timebase.

5. If the Control panel opens with the controls not yet active, connect the
ICS-90 to the Control panel by clicking the Connect button.

A dialog box appears (see Figure 2-11).

Form Properties | ]

General TimebaSBlStyle |Color |

Timebase: - Wy Computer
-85 Favarites
-2 Network Neighbothood

Computer:

Protocol:

| [

Enter connection information
manually or pick atimebase fram
the list at right.

oK I Cancel | Al | Help |

Figure 2-11. Connect to Timebase

6. Click the plus sign beside My Computer on the right side of the
dialog box and select the timebase you created in Section 2.5.1. Click
OK to close the dialog box.

The controls on the panel are now connected
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253

Verifying Communication with the ICS-90

To verify that Chromeleon or Chromeleon Xpress is communicating with
the 1CS-90, click the Disconnect and then the Connect button on the
Control panel while observing the ICS-90 front panel LEDs.

If the ICS-90 and the chromatography software are communicating
correctly, the Power and Ready LEDs are on when the ICS-90 is
connected to Chromeleon or Chromeleon Xpress, and only the Power
LED is on when it is disconnected.

® Power ® Power
@ Ready O Ready
O Run O Run
Connected Disconnected

Figure 2-12. 1CS-90 LEDs Connected and Disconnected States

20

Doc. 031856-03 12/06



2 « Installing the ICS-90 System

2.6 Connecting the Waste Lines

Untape the coiled waste and liquid lines from the rear panel. Place the ends of the
three waste lines into a waste container. The waste lines siphon off prime waste
from the pump head, sample overflow from the injection valve, and system waste
from the suppressor.

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

A DCR waste backpressure tubing assembly (P/N 060214) is installed

on the free end of the MMS IIl waste line (see Figure 2-13). The
IMPORTANT : )

assembly consists of a coupler and a 6-inch length of 0.25-mm

(0.010-in) ID black tubing.

The tubing assembly provides a small amount of backpressure to
compress any air bubbles formed in the suppressor’s regenerant
chamber. If you shorten or replace the MMS lll waste line, remember to
reinstall the backpressure tubing assembly. Failure to do so will result
in high baseline drift.

Coupler
i M K_ 0.25-mm (0.010-in) ID
W Black Tubing

Bt Suppressor

Waste Line

Figure 2-13. DCR Waste Backpressure Tubing Assembly
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2.7 Connecting the Gas Source

1. Locate the barbed fitting (P/N 030071), pipe thread reducer (P/N 030087),
3-mm (1/8-in) ID tubing (P/N 040793), and 1CS-90 air regulator accessory
(P/N 060054) in the ICS-90 Ship Kit.

2. Use the barbed fitting and pipe thread reducer to connect the 3-mm (1/8-in)
ID tubing to a clean gas source. The gas source should be regulated to
between 0.55 and 0.83 MPa (80 and 120 psi).

3. Push the other end of the tubing onto the inlet of the air regulator (see
Figure 2-14).

NOTE Do not turn on the gas source. Do not pressurize until
the eluent is prepared and the 1CS-90 is plumbed.

Eluent Gas Line

J

Gas Inlet Line
3-mm (1/8-in) ID

Connect to gas
source

Figure 2-14. 1CS-90 Air Regulator Accessory
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2.8 Setting Up the Eluent and Regenerant Reservoirs

1. Rinse the eluent and regenerant reservoirs.

2. Prepare 2 L of eluent. For instructions, see the manual for the column being
installed. The column manual is included on the Dionex Reference Library
CD-ROM (P/N 055405), located in the Ship Kit.

3. Follow the instructions below to prepare either anion (dilute sulfuric acid) or
cation (tetrabutylammonium hydroxide (TBAOH)) regenerant.

a. Fill the regenerant reservoir (anion, P/N 057712; cation, P/N 057713)
about halfway with ASTM filtered, Type I (18-megohm) deionized (DI)
water.

For acid concentrates (such as the anion regenerant), always pour the

concentrate into deionized water, not into the empty reservair.
CAUTION

Pour les concentrés acides (comme le régénérant anionique), versez
toujours le concentré dans de l'eau désionisée et non dans le

réservoir vide.
MISE EN GARDE

Giellen Sie bei saurehaltigen Konzentraten (beispielsweise dem
Kationenelutionsmittel) das Konzentrat immer in entionisiertes
Wasser und nicht in den leeren Behaélter.

VORSICHT
b. Empty the entire bottle of concentrate into the reservoir.

c. Fill the concentrate bottle with DI water and empty the contents into the
reservoir.

d. Continue to pour DI water into the reservoir until it is filled all the way to
the top. If a few drops spill over, then it is full enough.

The regenerant reservoir must be filled all the way to the top at all
IMPORTANT] 4imes.

e. Insert the stopper assembly tubing into the reservoir and tighten the
stopper.

Do not shake the regenerant reservoir to mix the contents. The ICS-90
IMPORTANT] \yjj| stratify the contents.
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For additional information, refer to the Installation Instructions and
Troubleshooting Guide for the Displacement Chemical Regeneration
(DCR) Kit (Document No. 031664). The manual is included on the
Dionex Reference Library CD-ROM (P/N 055405), located in the 1CS-90
Ship Kit.

Make sure the regenerant reservoir is filled almost to overflowing.
Slip the air regulator accessory bracket over the neck of the eluent reservoir.
Install the caps on the eluent and regenerant reservoirs and hand tighten.

Place the reservoirs in the holders on the top cover of the ICS-90.

© N o g &

Connect the liquid lines from the 1CS-90 to the lines exiting the eluent and
regenerant reservoir caps (see Figure 2-15) as follows:

a. Connect the two lines labeled Eluent Bottle Out.
b. Connect the two lines labeled Regen Bottle Out.

c. Connect the line labeled Regen In to the green Regen Bottle In line from
the 1CS-90.

Eluent Bottle -
Out Line s Regen Bottle
o™ \ Out Line
Eluent Gas ' ™
‘ \\Regen Bottle

Line
In Line

B REGEN
Gas Inlet Line
(from gas source)

Figure 2-15. Reservoir Connections
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2 « Installing the ICS-90 System

9. To ensure the correct operating pressure for the suppressor, either one or two
backpressure coil(s) (P/N 045877) must be installed between the cell outlet
and the regenerant reservoir inlet. The number of coils required depends upon
the application flow rate:

Number of Required
Backpressure Coils

Less than 2 mL/min 2
2 mL/min or more 1

a. For flow rates less than 2 mL/min, verify that two coils are installed.

b. For flow rates of 2 mL/min or more, remove one of the backpressure
coils.

NOTE Refer to the flier Backpressure Coil Pressure Test for
Dionex Suppressors (Document No. 031759)
(shipped with the suppressor) for details about
suppressor operating pressure requirements.

10. Connect the orange gas line from the eluent reservoir to the gas line on the air
regulator outlet.

2.9 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. For
detailed installation information, refer to the column
and suppressor manuals provided on the Dionex
Reference Library CD-ROM (P/N 055405).

1. Remove the guard column, separator column, and MMS 111 suppressor from
their boxes. Remove the fitting plugs from the ends of each column and from
all ports on the suppressor. Discard the tubing that temporarily connected the
SUppressor ports.

2. Plumb the guard and separator columns. Refer to the labels on the tubing, to
Figure 2-16, and to the following instructions.
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a. Remove the union connecting GUARD IN and GUARD OUT and connect
GUARD IN to the guard column inlet. Check the arrow on the column
label; it should point away from the injection valve.

b. Connect GUARD OUT to the guard column outlet.

c. Push the guard column onto the clips.

d. Remove the union connecting COL IN and COL OUT and connect COL IN to

the separator column inlet. Connect cOL OUT to the separator column
outlet. Check the arrow on the column label. It should point toward the
cell (DS5).

e. Push the column onto the clips.

ﬁ Serial Number

Eluent
In/Out
Union

(remove)

Regen In/Out
Union (remove)

Suppressor
Brackets

Cell Out
Union

Verify that 1
or 2 back-
pressure
coils are
installed (not
shown in
photo)

Do not
remove

Column
In/Out
Union

(remove)

Guard In/Out Union (remove)

Figure 2-16. 1CS-90 Component Panel (Door not shown)
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3. Plumb the MMS 111 suppressor as follows:

a. Install the suppressor onto the brackets located below the DS5 (see
Figures 2-16 and 2-17).

b. Remove the union connecting ELUENT IN and ELUENT OUT and connect
ELUENT IN and ELUENT OUT to the corresponding ports on the suppressor.

c. Remove the union connecting REGEN IN and REGEN OUT and connect
REGEN IN and REGEN OUT to the corresponding ports on the suppressor.

MMS I
Suppressor

Separator
Column

Side slot for
autosampler
line

Figure 2-17. 1CS-90 with Columns and Suppressor Installed

4. To ensure the correct operating pressure for the suppressor, either one or two
backpressure coil(s) (P/N 045877) must be installed between the cell outlet
and the regenerant reservoir inlet. The number of coils required depends upon
the application flow rate:

Less than 2 mL/min 2
2 mL/min or more 1
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a. For flow rates less than 2 mL/min, verify that two coils are installed.
b. For flow rates of 2 mL/min or more, remove one of the backpressure
coils.

NOTE Refer to the flier Backpressure Coil Pressure Test for
Dionex Suppressors (Document No. 031759)
(shipped with the suppressor) for details about
suppressor operating pressure requirements.

2.10 Pressurizing the Eluent Reservoir
NOTE Do not pressurize the regenerant reservoir.

1. Pull out the air regulator knob and turn it fully counterclockwise to ensure
there is no pressure to the reservoir when the gas source is turned on.

Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the eluent
reservoir.

4. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the regulator
knob back in.

Do not pressurize the eluent reservoir above 70 kPa (10 psi).

CAUTION
Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure a 0,07 MPa (10 Ib/po?).

MISE EN GARDE
Setzen Sie den Eluentbehélter auf keinen Fall einem Druck Uber
0,07 MPa aus.

VORSICHT
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2.11 Priming the Pump

1. \Verify that the eluent and regenerant reservoirs are filled, the reservoir caps
are installed and hand-tightened, and the gas and liquid lines are connected to
the reservoirs (see Section 2.8).

2. Verify that the gas supply is turned on, the eluent reservoir is pressurized (see
Section 2.10), and the regenerant reservoir is unpressurized. Note: The
regenerant reservoir is unpressurized if the reservoirs are connected as
described in Section 2.8.

3. Verify that the waste lines are directed to a waste container.

4. To start the liquid flow, open the pump head waste valve (see Figure 2-18) by
turning the knob counterclockwise two turns. When the valve is open, eluent
flows directly from the pump to waste.

Pulse
Damper

Pump Head
Waste Valve

Pump Flow
Rate Knob

Figure 2-18. 1CS-90 Interior Components

5. Let the liquid flow for at least 2 to 3 minutes to ensure that there are no
trapped gas bubbles in the line from the eluent reservoir to the pump head.
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6. Turn on the pump from the ICS-90 (or ICS-90A) Control panel in
Chromeleon or Chromeleon Xpress. Allow the pump to run with the waste
valve open for 30 seconds.

7. Close the waste valve knob.

2.12 Setting the Pump Flow Rate (ICS-90 only)

The instructions in this section apply to the 1CS-90 only. If you are unsure
whether your system is an 1CS-90 or ICS-90A, check the model data label on the
rear panel.

2.12.1 Setting the Flow Rate

1. Locate the production test chromatogram on the Dionex Quality
Assurance Report (supplied with the separator column). Note the
backpressure and flow rate listed for the column.

2. Pull out the flow rate knob on the component mounting panel (see
Figure 2-18) and turn the knob slowly to the right to begin adjusting
the pressure.

NOTES

® There is about a 10-second delay between adjusting the knob and
the pressure reading response on the 1CS-90 Control panel in
Chromeleon or Chromeleon Xpress.

® The flow rate on the ICS-90 Control panel is a recorded value only
and does not change when the flow rate knob is adjusted.

3. Adjust the knob until the pump pressure reading on the 1CS-90
Control panel reaches the figure listed on the production test
chromatogram.

NOTE The production test chromatogram is produced
without a guard column. If a guard column is
installed, adjust the knob until the pressure is about
14 to 21MPa (200 to 300 psi) above the
backpressure listed for the separator column alone.
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4. Measure the flow rate, using one of the following methods:

= \olumetrically (recommended for most applications): Measure
the volume of liquid collected over a measured time period. The
ICS-90 Ship Kit includes items for measuring the flow rate
volumetrically.

e Gravimetrically: Weigh the mass of liquid collected over a
measured time period. The gravimetric method is slightly more
accurate than the volumetric method.

Volumetric Method 1 (Recommended): Using a Syringe and Adapter

a. Locate the following items in the ICS-90 Ship Kit: luer fitting
(P/N 024305), luer coupler (P/N 042806), 1 mL syringe (P/N 016388),
and 10 mL syringe (P/N 016387). You will also need a stopwatch or a
clock or watch with a second hand (the computer’s clock can be used),
and a small beaker or other container for collecting waste.

b. Connect the luer coupler to the luer fitting.
c. Select the syringe to be used:
e Fora 0.5 mL/min flow rate, use the 1 mL syringe.
e For a flow rate above 0.5 mL/min, use the10 mL syringe.

d. Disconnect the ELUENT IN line from the ELUENT IN port on the
suppressor. Connect the luer coupler to the ELUENT IN line, and connect
the syringe to the luer fitting (see Figure 2-19).

Eluent In

Syringe Line

Luer
Coupler

Luer
Fitting

Figure 2-19. Assembled Syringe and Luer Adapter
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h.

Using a stopwatch or clock’s second hand, time the flow of eluent into the
syringe for 60 seconds. Determine the volume collected by noting the
beginning and ending positions of the syringe plunger.

The volume of eluent collected in 60 seconds should be approximately
equal to the desired flow rate in milliliters per minute. For example, for a
flow rate of 1 mL/min, the volume should be 1.0 + 0.1 mL.

If necessary, adjust the flow rate knob, and then repeat the measurement.
Continue adjusting until the desired milliliters per minute is collected.

Reconnect the ELUENT IN line to the suppressor.

Volumetric Method 2: Using a Graduated Cylinder

a.

e.

Disconnect the ELUENT IN line from the ELUENT IN port on the
suppressor.

Using a clock or watch with a second hand (the computer’s clock can be
used), collect eluent from the ELUENT IN line into a small graduated
cylinder for 2 minutes.

The collected eluent should be approximately equal to the desired flow
rate in milliliters per minute. For example, for a flow rate of 1 mL/min,
2.0 £ 0.2 mL should be collected in 2 minutes.

If necessary, adjust the flow rate knob, and then repeat the measurement.
Continue adjustments until the desired eluent per minute is collected.

Reconnect the ELUENT IN line to the suppressor.

Gravimetric Method

a.

Disconnect the ELUENT IN line from the ELUENT IN port on the
suppressor.

Using a tared beaker and a calibrated stopwatch, collect the eluent from
the ELUENT IN line for 60 seconds.

Weigh the mass of the eluent. The mass (in grams) should be
approximately equal to the desired flow rate in milliliters per minute. For
example, for a flow rate of 0.5 mL/min, the mass of the collected eluent
should be 0.5 + 0.02 g.

If necessary, adjust the flow rate knob, and then repeat Steps b and c.
Continue adjusting until the desired mass per minute is collected.

Reconnect the ELUENT IN line to the suppressor.
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2.12.2 Recording the Measured Flow Rate

1. From the ICS-90 Control panel, press the F8 key or select Control >
Command.

2. Expand the Pump_ECD group and select MeasuredFlowRate (see
Figure 2-20).

Commands - IC5-80 ]
H-GE System ~! Betention Time: I [min]

£ Pump_ECD

-6 ECD_1 tMeasuradFlowRate: |1 'l [0..5 mL/min]
H-E8 Pump_ECD_TTL_1

H-E Pump_Injectvalve

H-E8 Pump_ECD_Calibration

H-E Pump_ECD_Diagnostic

@ Pump

Wk ticasuredFlowRate
@ DummyCell

-8 TotalCanductivity
#-Bf] Pressure

8 CellDrive/oltage
----- P4 Autozero

B Offset_value

WA mmanicition Do ;I

B
B
B
B

—Help
The flow rate set and wverified by the user. Note that the software can not contral or maonitar the flow rate.

Command: | MeasuredFlowRate = 1

| coe_|

Figure 2-20. 1CS-90 Chromeleon Commands: MeasuredFlowRate

3. Enter the flow rate and click Execute. Click Close. The measured
flow rate is now shown on the Control panel.
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2.13

2.14

Setting the Pump Flow Rate (ICS-90A only)

NOTE The instructions in this section apply to the 1CS-90A
only. If you are unsure whether your system is an 1CS-90
or ICS-90A, check the model data label on the rear
panel.

The ICS-90A has a feature that allows the approximate flow rate to be displayed
on the Control panel in Chromeleon or Chromeleon Xpress. The accuracy of the
displayed flow rate depends on the flow rate at which the system was calibrated
and the current pump pressure.

The ICS-90A flow rate is calibrated at the factory before shipment and does not
need to be calibrated now. However, if you will typically operate the ICS-90A at a
particular flow rate, you may wish to calibrate the system at that flow rate to
improve flow rate accuracy. For instructions, see the ICS-90 lon Chromatography
System Operator’s Manual (Document No. 031851). The manual is included on
the Dionex Reference Library CD-ROM (P/N 055405).

To set the pump flow rate:

Pull out the flow rate knob on the component mounting panel (see Figure 2-18)
and turn the knob until the desired flow rate is displayed on the ICS-90A Control
panel in Chromeleon or Chromeleon Xpress.

Equilibrating the System

1. After priming the pump and adjusting the flow rate, leave the pump on and
flush the system for about 5 minutes to equilibrate.

2. Monitor the system pressure from the ICS-90 (or ICS-90A) Control panel to
make sure the pressure is between 107 and 153 MPa (1600 and 2300 psi). If
the pressure is less than 107 MPa (1600 psi), gas may be trapped in the
system. Release the gas by opening one fitting at a time from the pump head
and along the plumbing to the column; pay close attention to the line from the

pulse damper (see Figure 2-18).
3. Check that there are no leaks in the regenerant reservoir.

4. Check that liquid is flowing out of the suppressor REGEN OUT waste line and
that the pressure is stable.

34
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5. Monitor the baseline conductivity. In general, it should be <30 uS for a system
set up for anion analyses, and <2 uS for a system set up for cation analyses.

2.15 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by
monitoring the pump pressure. Record the short-term pressure fluctuations; they
should be less than 0.13 MPa (20 psi).

2.16 Connecting the AS40 Automated Sampler (Optional)
1. Open the front door of the ICS-90 and thread the outlet line from the AS40
through the side slot near the lower ICS-90 door hinge (see Figure 2-17).

2. Connect the outlet line from the AS40 to port S (5) of the injection valve (see
Figure 2-21).

\ To Column

—— From Pump

Sample Loop

Figure 2-21. Injection Valve Connections

3. Follow the steps below to connect the TTL Output connector on the ICS-90
rear panel to the RELAY CONTROL connector on the AS40 rear panel.

a. Locate the Relay Control cable (P/N 047946) supplied with the AS40.

b. Connect the Relay Control cable's 10-pin connector to the RELAY
CONTROL connector on the AS40 rear panel (see Figure 2-22).
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AS40 Rear Panel ICS-90 Rear Panel

UsSB
RELAY CONTROL

READY OUT

) Vi
vial
| —
Mot used here
am

Load

Relay Control Cable

[Ready |I

Figure 2-22. AS40 Autosampler Connection

c. Plug the 2-pin connector from the pair of wires labeled LOAD on the
Relay Control cable into the TTL Output connector on the ICS-90.

2.17 Operating the ICS-90

2.18

ICS-90 installation is complete. For routine operation, refer to the ICS-90 lon
Chromatography System Operator’s Manual (Document No. 031851).

Installation Troubleshooting

Problem: When the 1CS-90 power is turned on for the first time, a Windows
message box appears asking for a USB configuration file (cmwdmusb.inf).

Possible Cause: The USB cable was connected and the power turned on before
Chromeleon or Chromeleon Xpress was installed.

Solution:

1.

2
3.
4

Click the Cancel button in the Windows message box.
Turn off the 1ICS-90 power and unplug the USB cable from the computer.
Install Chromeleon or Chromeleon Xpress (see Section 2.1).

Reconnect the USB cable to the computer and turn on the 1CS-90 power.
Windows will now automatically recognize the new 1CS-90.
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